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1 PREFACE 

The iQ-Automator software provides a substantial time saver for testing your mobile phones while eliminating 

human error and creating more precise and accurate testing. The software can control the iQ-Automator Solution 

and create a testing sequence. 

 

iQ-Automator GUI 

 

1.1 Minimum requirements  

• Windows 10 32bit 

• USB 2.0 or higher 

• Ethernet connector (for robot arm) 

1.2 Installation  

The iQ-Automator control software is available in 32bit. During installation, the drivers and additional software 

will be installed. Along with the iQ-Automator software, the installation includes the following: 

• Microsoft Visual C++ Redistributable Package 

• Hardware drivers 
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1.3 Safety instructions  

1.3.1 Danger  

• Make sure to install the robot and all electrical equipment according to the 

specifications. 

1.3.2 Warning 

• Ensure the robot arm and tools are correctly and securely bolted in place.  

• Confirm that the robot arm has ample space to operate freely. 

• As defined in the risk assessment, verify that safety measures and the robot safety configuration 

parameters have been set up to protect programmers, operators, and bystanders. 

• Do not wear loose clothing or jewelry when working with the robot. Make sure long hair is tied back 

when working with the robot. 

• Never use the robot if it is damaged. 

• If the software prompts a fatal error, immediately activate the emergency stop, write down the conditions 

that led to the mistake, find the corresponding error codes on the log screen, and contact Image 

Engineering. 

• Do not connect any safety equipment to standard inputs/outputs. Only use safety-related interfaces. 

• Use the correct installation settings (e.g., robot mounting angle, weight in TCP, TCP offset, and safety 

configuration). Save and load the installation file along with the program. 

• Use the free drive function (impedance/back-drive) only in installations where the risk assessment allows 

it. Tools and obstacles should not have sharp edges or pinch points. Ensure all personnel keeps their 

heads and faces outside the robot's reach. 

• Be aware of the movement of the robot when using the teach pendant. 

• Do not enter the safety range of the robot or touch the robot when the system is in operation. 

• Collisions can release high portions of kinetic energy, significantly higher at high speeds and with large 

payloads.  

• Combining different machines might increase hazards or create new dangers. Always do an overall risk 

assessment for the complete installation. Always choose the highest level when other safety and 

emergency stop performance levels are needed. Be sure to read and understand the manuals of all the 

equipment used in the installation. 

• Never modify the robot, as a modification might create unforeseen hazards for the integrator. All 

authorized reassembling shall be done according to the newest version of all relevant service manuals.  

1.3.3 Intended use  

The intent of the joint operation is only for non-hazardous applications. The complete application, including tools, 

workpieces, obstacles, and other machines, is without any significant hazards according to the risk assessment 

of the specific application. 

Any use or application deviating from the intended use is deemed to be impermissible misuse. This misuse 

includes, but is not limited to: 

• Use in potentially explosive environments 

• Use in medical and life-critical applications 

• Use before performing a risk assessment 
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• Use where the rated performance levels are insufficient 

• Use where the reaction times of the safety functions are insufficient 

• Use as a climbing aid 

• Operation outside the permissible operating parameters 

 

2 INITIALIZE ROBOT 

Please familiarize yourself with the robot arm (UR3e) user manual. This chapter only describes the steps 

necessary to work with the iQ-Automator software. When using the robot arm with the iQ-Automator software, it 

must be initialized with the connected controller tablet. 

 

Enter the current weight (payload) mounted on the tool plate (these weights are stated directly below).  

Weight of the iQ-Mobilemount plus the iQ-Trigger-T: ~1080 g 
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2.1 Set-up Robot Arm network 

 

 

 

 

 

 

 

 

 

 

 

 

 

An Ethernet connection is not necessary for the basic robot functions and is disabled by default. To work with the 

iQ-Automator, please enable DHCP or set a static IP address. In both cases, the IP address must be entered 

later in the software (see chapter Error! Reference source not found.). 
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2.2 Check digital output mode 

 

Please check that the “Tool Output Voltage” is set to 0. 
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2.3 Enable remote control  

 

Please be aware that if you enable “Remote Control,” some control panel functionality is disabled.  
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Once enabled, you can switch between local and remote control with the “Local” button on the top right corner of 

the interface.   
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2.4 Start Robot Arm  

 

You need to weigh the device under test during this step and input the value into “Active Payload.” Please 

note that the weight of the device under test does not need to be exact. We recommend that you take the 

average of a few different mobile phones and use that value as your “Active Payload,” so you don’t need to 

measure the exact weight of every mobile phone.  

Attention! Please add the weight of your device under test to the weight of the Installation 

Payload. Enter the sum into “Active Payload.” For example, Installation Payload is 1.5 kg, and 

the DUT weight is 200 g. The value you need to enter into the “Active Payload” space is 1.7 

kg.  

 

Once that is complete, you can click the “on” button. 
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Once you click “On” (see the previous image), the button will change to “Start,” and you can click it once 

the program has completed booting and the robot arm is in normal mode. 
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These steps are all necessary for starting the program. Once activated, please check to ensure everything is 

actively working (all green circles with checks). For all other actions, please refer to the robot arm manual.  
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2.5 Mobile phone mounting 

Mount the mobile phone on the iQ-Mobilemount, as shown in the images. Align the lens to the center of the tool 

plate.  
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Attach the iQ-Trigger-T to the phone using the rubber band. Place the active area of the iQ-Trigger-T over the 

release button of the native camera application. Connect the phone with the USB cable to the USB extension 

cable. 

 

 

2.6 Tool Center Point (TCP)  

The tool center point is defined as a target position in space to the coordinate origin of the robot arm's mounting 

plate. In the context of the iQ-Automator, the TCP needs to be set to the lens of the mounted phone. 

If the phone is correctly aligned with the lens perpendicular to the mounting plate's center, then only the vertical 

distance of the lens to the mounting plate needs to be measured (z-coordinate). Enter the value into the software 

(see chapter Error! Reference source not found.). 

 

Align the measurement tool with the lens and then record the vertical distance. 
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3  SOFTWARE USAGE  

Along with the different Image Engineering hardware components, the iQ-Automator software provides an 

efficient and time-effective option to automatically test and give feedback on the image quality of a digital 

camera. The software enables users to create workflows involving various connected Image Engineering 

devices. The critical elements of this solution are the iQ-Bench and the robot arm with six degrees of freedom. 

The combination of translation and rotation movement and the ability to control motor-driven devices, iQ-LED-

powered devices, and iQ-Standardlight devices provides the basis of extraordinarily versatile software. 

Logging Functionality:  

The software writes a log.txt file to C:/Users/<user>/AppData/Roaming/Image Engineering/iQ-Automator. A lot of 

information for debugging purposes is saved here. If an error appears or a crash happens, copy this file to 

another directory and send it directly to Image Engineering support. This process helps us to detect errors and 

improve the software. 

3.1 First start  

Enter the license key when starting the software for the first time. You can find the key in a text file on the USB 

stick.  

3.2 Initial import of configuration files 

• In the iQ-Automator File menu, choose the Load configuration file and select the provided 

configuration files for all moving parts, the iQ-Bench, the robot arm, and the iQ-Teststand. Normally, the 

file that needs to be loaded is labeled IE_Drive_Configuration.xml, and it configures all dependent 

moving devices. 

• Choose File> Import hardware setup and select the provided XML files in the folder (select 

Hardware.xml and all others) to load your test chart setup.  Give this setup a name in the dialog. The 

XML files need to be configured first; see the iQ-Automator support document instructions. 

• If you have existing illuminant files for iQ-LED devices, choose file> Import illuminants and select the 

illuminant files. The illuminants are available in the software at each start-up. 

3.3 Set-up IP address of Robot Arm 

Go to Options > Set robot arm IP... to enter the IP address of the robot arm. Once confirmed, it should 

establish the connection to the robot arm. 
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3.4 Finding the home positions of the iQ-Bench and Robot Arm  

Click the Calibrate button to perform the homing procedure for the robot arm to find its default position on the 

iQ-Bench. The home switch on the front side defines the iQ-Bench's default position of the iQ-Bench.  The robot 

arm will simultaneously move its elements to designated (home) positions. 

 

The homing switch is released by the metal plate mounted at the front side of the carriage 

3.5 Image acquisition from the mobile phone for extracting EXIF data 

You must first meet some prerequisites for the auto-alignment procedure and the connection to the mobile 

phone. 

a) Before using the software, ensure that the mobile phone is set to file or image transfer mode when connected 

to a PC with the USB cable: 
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b) Verify the successful connection by opening the phone in Windows Explorer: 

 

c) In the "DCIM" directory (or a sub-directory), the images from the camera must be visible.  

 

 



 

   

  

 

 

Image Engineering  Seite 19 von 35 

d) Prepare the camera application. 

Set the camera resolution in the native camera application to the highest setting, in either the 4:3 or 16:9 format. 

This step is vital for the calculation of the pixel pitch of the camera's sensor. For example: 

 

Take a photo with the native camera application. The content does not matter; it is only used for extracting EXIF 

data. 

If the camera application is switched to the front-facing camera, there may be an option for flipping the image 

when it is saved. Please set it to a non-flipping state. For example: 

 

e) Connect the phone 

The phone name appears in the Options/Mobile devices menu when a mobile phone is connected to the PC and 

the software is running. The phone name appears in the Options/Mobile devices menu. For example: 
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The software needs some information from the EXIF data of an image captured with the phone. When 

connecting a phone of a dedicated model to the software for the first time, you should scan the device for such 

an image. After clicking "Start scanning device," the software chooses the picture from all the images on the 

phone with the latest modification date. The search can be restricted to the DCIM directory ("Use DCIM 

directory"), where the native camera application usually stores images. 

This image is copied to C:/Users/<user>/AppData/Roaming/Image Engineering/iQ-Automator. The software 

extracts two values (crop ((or scale)) factor and the focal length) from the EXIF meta information of the image 

file, which is required for the auto-alignment procedure. The focal length is read directly from the meta 

information, while the pixel pitch is calculated from other values. With these values and the positions of the red 

markers in the images taken during the alignment procedure, the software can calculate the correct alignment for 

the iQ-Bench and the robot arm. 

 

Let’s suppose that the EXIF data lacks such information, which means that at least one value is invalid. In that 

case, the user can enter the correct values for both focal length and pixel pitch from a datasheet or other 

sources of technical data. 

 

Once two correct values are available, they are stored permanently and used again if a phone of the same 

model type is connected.  
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3.5.1 Image acquisition from mobile phone for auto-alignment 

An auto-alignment for the target chart can be performed if the following issues are fulfilled: 

- The XML configuration for the chart has an AutoAlignment entry set to true with all necessary entries. 

The TargetDimensions entries have correct values for the red markers and the target size (see support 

document). 

- The phone is successfully connected (see chapter 2). 

- The mobile phone is mounted correctly on the iQ-Mobilemount (see chapter 2.5). 

- The iQ-Trigger is mounted on the release button of the phone's native camera application. 

- The Automator was taught the initial position where the first image will be taken. All four red markers 

must be seen on the monitor, and the robot arm should be arranged so that the viewing angle of the 

chart is minimized. This setup implies that the camera is aligned perpendicularly to the center of the 

target (e.g., the chart center). 

- The tool center point for the mobile phone lens has been measured and entered in the corresponding 

fields of the dialog mentioned above. 

- A minimal workflow with the target motion control element was created.  

- Calibrate button was clicked, and the iQ-Bench and robot arm moved to their home positions. 

 

Now, a successful alignment can be performed when the workflow is started. Check the performance by adding 

an iQ-Trigger task right after the motion control task. The iQ-Trigger rereleases the camera after alignment has 

finished, and the resulting image is saved to the disk. Verify that the target center (e.g., the central marker of a 

chart) is close to the image's center. During the alignment procedure, four images are taken, in which the four 

red markers are detected. Those images are also saved to C:/Users/<user>/AppData/Roaming/Image 

Engineering/iQ-Automator, but always with the same name, "temp.jpg," and only temporarily. After successfully 

detecting markers in the image, the temp image is deleted. 
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3.5.2 Mobile device settings and camera properties  

The connected mobile device is listed under Options > Mobile devices. When selected, a dialog with mobile 

phone settings appears. Additional information must be retrieved (one-time) from the image EXIF data from the 

mobile phone to execute the auto-alignment process correctly. The numbers in the following paragraphs refer to 

the numbers in the image. 

 

1. The manufacturer and the phone model name are displayed here. 

2. An image file must be available on the phone to obtain the correct EXIF data. The image must be in the 

highest resolution and captured in 4:3 or 16:9 mode. Start the native camera application, set the 

appropriate options, and take a sample image. When you click the "Start scanning device" button, the 

directory tree of the mobile phone is scanned for image files, and the one with the latest modification 

date is chosen for EXIF information retrieval. Depending on the number of images on the phone, this 

search may take some time. Click the button to start scanning after checking the settings described in 

the following two paragraphs. 

3. Usually, the native camera application stores its images in a directory called "DCIM." If the option "Use 

DCIM directory" is selected, the search will be restricted (default setting).  

4. Some mobile phones simultaneously store a thumbnail image next to the original one. This issue may 

lead to EXIF data accessing an invalid thumbnail image. In this case, a minimum value for the file size of 

the images is specified here. Images below this size are skipped during scanning. The default value is 

100 KB. After successful scanning, four distinct values from the EXIF data of the most recent image are 

displayed. Three values are directly extracted, and one is indirectly calculated from the others. 

5. The focal length of the lens is in mm. This value can be edited. 

6. As parameters, pixel pitch is calculated indirectly from the image size and the crop factor. This value can 

be edited. If you feel that the focal length and pixel pitch values are potentially imprecise, you can 

enter well-known values here. Both values are saved permanently to the disc and are reloaded 

whenever a mobile phone of the same model type is connected again. This feature avoids the scanning 

procedure and restores the current values. 

7. The equivalent focal length of 35 mm is displayed here for information purposes.  

1 

2 
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8. The crop (or scale) factor is the ratio between the physical focal length of the lens and the assumed 

equivalent for a 35 mm sensor (film) size. It is used for the calculation of the pixel pitch. 

9. Hold the mouse cursor over the info button to display the EXIF data's image. This feature will ensure that 

the EXIF information was not extracted from the wrong image. 

10. The release time for the iQ-Trigger-T can be edited here. The default value of 300 milliseconds is 

sufficient for most mobile phones. In rare cases, a smaller value of 200 ms is advisable due to the 

possibility that the camera application may enter the burst mode with 300 ms and capture a series of 

images instead of one. 

 

Finally, click OK to save all settings or Cancel to discard all settings. 

3.6 Tool Center Point (TCP) 

Go to Train robot arm > TCP setting in the Options menu. Enter the measured vertical distance (z-value) for 

the TCP (chapter 2.6): 

 

3.7 Training of Robot Arm and iQ-Bench (position recording) 

For each mobile device, the robot arm's initial positions and iQ-Bench need to be recorded and stored in the 

software. When "Train robot arm" is selected from the menu, the iQ-Bench and the robot arm can be released by 

clicking the "Release drives" button (this will allow you to adjust the robot arm manually). Please ensure that 

someone is holding the robot arm at this moment, so it does not collapse. The person holding the arm can now 

freely move the arm and adjust the base plate on the bench to show all four red markers on the mobile phone 

screen. The position should be chosen with respect to the following conditions: 

• Only the four red markers that belong to the chart are visible in the display. If the iQ-Automator in your 

setup includes an iQ-Chartmount with other charts, please ensure that no other red marker is visible. In 

addition, other red artifacts with similar size and roundness may impact the auto-alignment procedure. 
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• Please ensure that when freely moving the arm, it is moved in the correct position. Review the following 

images for the proper movement.  

 

Examples of incorrect positioning, which leads to failure of alignment procedure: 

 

 

 

Examples of acceptable positioning: 
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• After this coarse alignment, click "Lock drives" and "Save position." 

• Now a new task workflow for this mobile phone needs to be created. 
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3.7.1 Train the positions of the test devices 

Select Train robot arm > TCP setting in the Options menu. For each mobile phone type, each test chart must 

provide an initial position of the bench and robot arm. This position is either the starting position for the auto-

alignment procedure or the final position in the case of manual alignment. The use case for each destination 

chart is defined in the XML files for the hardware setup. The auto-alignment requires four red markers to be 

mounted around the destination chart and corresponding entries in the XML configuration (see support 

document). Usually, the complete setup of devices, test charts, XML configurations, and red markers is 

performed during the commissioning of the iQ-Automator. For subsequent amendments, please get in touch with 

the Image Engineering support team. 

The following procedure should be performed by two people, one who operates the software and the other who 

moves the bench and robot arm to the initial position. Although the robot controller can hold its joints in place 

when the brakes are released, a person should hold the robot arm when clicking the Release drives button to 

ensure the arm doesn’t collapse. 

 

• Click the Release drives button to unlock the iQ-Bench and the robot arm. The second person can now 

move the carriage of the iQ-Bench and the robot arm to the desired position. The monitor of the mobile 

phone should display the target chart so that all four red markers are visible and not too far from the 

frame borders: 
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During movement, the positions of all movable parts are updated. 

• Click the Lock drives button. 

• To save the current position, click Save position. 

• Click Done to leave the setup dialog.  

 

All workflows created with auto-alignment configurations now use the recorded position as the initial position.  

 

4 TASK ITEMS – CONTROL OF AUTOMATOR COMPONENTS 

 

The available items are separated into three different sections including: 

• Devices for illumination, such as the iQ-Flatlights, and devices for image capturing, e.g., the iQ-Trigger. 

• Motion control items for the main bench, the robot arm, and devices such as the moving targets of a 

lightSTUDIO-M. 

• Scripting for the control of the mobile phone with the ADB tool or an evaluation with the iQ-Analyzer 

command-line tool. 

 

A workflow may consist of different items from these sections. 
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4.1 Illumination devices  

This section connects each illumination device that is based on iQ-LED or iQ-Standardlight technology. The iQ-

Trigger control can also be connected here. 

4.2 Motion control items 

Blue items: represent the moving parts of the iQ-Bench and the robot arm toward a target chart. These items 

are configured with XML files and perform an auto-alignment with an initially trained position. 

Green items: represent the movements of other connected moving parts. These items are configured with XML 

files and perform a manual alignment with an initially trained position. 

Orange items: represent individual movements of the robot arm or any other moving device with no specific 

target. These movements are configured in the workflow editor. 

4.3 Script  

The script tile enables you to write or call batch scripts. 

5 WORKFLOW EDITOR 

 

Drag and drop the desired items to the track and create a workflow with the different task items. All tasks in a 

workflow are executed subsequently. The maximum number of slots for tasks in the workflow track can be 

changed. 

 

5.1 Task settings 

The blue and green motion task items have no specific settings since they are configured in the XML files. All 

other task items can be edited by simply double-clicking on them. 
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5.1.1 Illumination  

 

Illumination settings 

The illumination settings panel offers control options for iQ-Standardlight devices and all types of iQ-LED 

devices. Illuminant files are available for a connected iQ-LED illumination device, such as iQ-Flatlights, and 

those illuminants can be selected here. See chapter Error! Reference source not found. for importing 

illuminant files. iQ-LED illumination files must be created using the iQ-LED software. After that, select the 

illumination device and a corresponding illuminant. For example, multiple devices, such as two iQ-Flatlights with 

the same illuminant for test chart illumination, can be chosen. 

5.1.2 iQ-Trigger 

 

The iQ-Trigger task item captures the final image after successful alignment (automatic or manual). The trigger 

time sets the release time of the iQ-Trigger-T. The default value of 0.3s applies to most mobile devices. In rare 
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cases, this release time may provoke the burst mode of the camera application. A value of 0.2s should then be 

set for this device.  

 

Delay to the next task defines the time in seconds until the next task item is executed. This option can be helpful 

if the camera needs some time to focus after the trigger is released. 

5.1.3 iQ-Trigger release time 

If an iQ-Trigger task is dragged to the task timeline, the default release time for the iQ-trigger is set to 0.2s. 

During a few use cases, it was discovered that this value might be too short for some phones, leading to random 

dropouts of camera releases. Try to increase the release time in 0.1s steps until the iQ-trigger reliably releases 

the camera. 

  

Contrary to this, an extended-release time may start the camera exposure in burst mode. For some phones, a 

release time of 0.3s or 0.4s may be too long and lets the camera take a series of images. 

 

5.1.4 Robot Arm 

 

The robot arm can be moved to any position within its tool workspace. Please be aware that combinations of the 

six parameters (for the six joints) are outside this workspace. Using the UR controller in advance is 

recommended to test possible destinations. Read the manual of your robot arm for further information about the 

workspace. You may also release the brakes of the robot arm to move it to a target position and then save these 

values here. 
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5.1.5 Axes  

 

Each axis connected to the PC can be moved to any desired position. In general, it is the main iQ-Bench with the 

robot arm, but the moveable parts of a lightSTUDIO-M may also be used here when it is connected. A looping 

function is also included. 

6 THE SCRIPT TASK 

The script task console uses the Windows command prompt (cmd.exe) and its syntax. A temporary batch file 

*.bat is created from your input in the script task console and executed as a task. This process enables the iQ-

Automator to launch applications such as the iQ-Analyzer for image evaluation. You also have the option to run 

your python scripts. 

If the checkbox "Wait for finished" is checked, the iQ-Automator will proceed with the next task after the 

executed batch file has finished. Otherwise, the process will be done in the background while other tasks are 

performed. 
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6.1 Example 1: Workflow with iQ-Analyzer: 

 

When processing images with a TE42 test chart and the iQ-Analyzer, please add the following lines to the 

scripting text field: 

For versions < 6.2 

cd /d C:\<Path to iQ-Analyzer>\iQ-Analyzer V6.1.9iqa6cmd.exe "%IQ_IMAGE_PATH%*.jpg" “C:\<Path 

to iQ-Analyzer>\iQ-Analyzer V6.1.9\Data\TE42_V2_Data.42” 42 

Analyzer versions >= 6.2 

In the iQ-Automator application %IQ_IMAGE_PATH%, you will find the reserved variable containing the path to 

the folder where the previously captured image is located. 

For further information on using the iQ-Analyzer command-line tool, please read the iQ-Analyzer manual. 

 

The iQ-Analyzer should not be installed in C:\Program Files\ to use the command-line application in the iQ-

Automator software. Instead, install the iQ-Analyzer to C:\Image Engineering\iQ-Analyzer. 

6.2 Example 2: start-up mobile device 

Most mobile phones shut down the camera application and enter sleep mode if not actively used, disrupting your 

test proceedings. As a result, it is crucial to ensure the phone is awake and unlocked by starting the camera 

application manually. Creating a script to automate this procedure through the ADB (Android Debug Bridge) is 

also possible. Download the ADB tool and install it to an appropriate destination on your PC (e.g., C:\Program 

Files\ADB\). With the ADB shell command, some UI input events of the phone can be simulated. The input 

command-line tool is used for this purpose. 

 

Here is a sample for a phone that has no password protection: 
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1) Generates a keypress event for powering up 

2) Generates a swipe gesture from coordinates 500,1500 to 500, 500 (swipe up) 

3) Generates a keypress event for starting the camera application 

C:\Program Files\ADB\adb.exe shell input keyevent 26  

timeout 2 

C:\Program Files\ADB\adb.exe shell input touchscreen swipe 500 1500 500 500  

timeout 2 

C:\Program Files\ADB\adb.exe shell "input keyevent = CAMERA" 

 

6.2.1 Workflows  

 

After all desired tasks are configured, save the tasks to a workflow item. Click Create workflow, enter a self-

explanatory name, and set an icon or a color (optional). Be aware that the workflow depends on the trained 

position for the current device and the camera settings, so we recommend adding the mobile phone type and 
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some other information to the name. An example: 

<Manufacturer> <Phone Name> <TE42> <4:3> 

 

After confirmation, the workflow editor is cleared, and a workflow tile is added to the workflow collection. 

 

Double-click the desired tile to change an existing workflow item. A new window will appear with all task items. 

Click Copy to workflow editor. The task items can now be edited, and a new workflow can be created again. 

Choose a different name for the workflow or delete the old workflow item. 

6.3 Process workflow 

 

To begin, drag and drop a workflow item to the Workflows sequence and click the Start button. 

7 3RD PARTY COMPONENTS  

The iQ-Automator software uses open-source software: 

libusb (www.libusb.org) is licensed under the GNU Lesser General Public License version 2.1 or later 

(www.gnu.org/licenses/old-licenses/lgpl-2.1.html). 

http://www.libusb.org/
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html
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The Qt framework (www.qt.io)  is licensed under the commercial Qt license. 

 

OpenCV (https://opencv.org) 

License Agreement  

For Open-Source Computer Vision Library  

(3-clause BSD License)  

Redistribution and use in source and binary forms, with or without modification, are permitted, provided that the 

following conditions are met: 

• Redistributions of source code must retain the above copyright notice, this list of conditions, and the 

following disclaimer. 

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

• Neither the names of the copyright holders nor the names of the contributors may be used to endorse or 

promote products derived from this software without specific prior written permission. 

 

This software is provided by the copyright holders and contributors "as is," and any express or implied 

warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular 

purpose, are disclaimed. In no event shall copyright holders or contributors be liable for any direct, indirect, 

incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute 

goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of 

liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the 

use of this software, even if advised of the possibility of such damage. 

 

Exiftool (https://www.sno.phy.queensu.ca/~phil/exiftool/) is free software licensed under the GNU Lesser 

General Public License version 3.0 or later (www.gnu.org/licenses/lgpl-3.0). 

 

 

https://www.qt.io/
http://www.qt.io/
https://opencv.org/
https://www.sno.phy.queensu.ca/~phil/exiftool/
https://www.gnu.org/licenses/lgpl-3.0

